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Chapter 1: Getting started

Computer requirements 2
Installation packages 2
Activation connectivity 2

Using SMART Install Manager 3
Using ActivationWizard 3

This guide explains how to customize and deploy the following software:

l SMART Notebook 16 collaborative learning software

l SMART Product Drivers 12.5
l SMART Ink™ 4

l SMART Response® 2016 assessment software

l Handwriting recognition

l SMART Common Files

NOTE

For information on customizing and deploying previous versions of this software, see the

appropriate system administrator’s guides at smarttech.com/support.

This guide is intended for IT administrators and others experienced with customizing, deploying

and administering software onMac computers in a networked environment. To use this guide, you

must:

l Know how to complete basic administrative tasks in OS X operating system software such as

working in Terminal

l Have administrative privileges and access to servers

l Have access to the DVD or to the Internet

http://www.smarttech.com/support
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Computer requirements

NOTE

Operating systems and other third-party software released after this SMART software might not

be supported.

Before you install the software, ensure your teachers’ computers meet the minimum requirements:

Supported
operating systems

OS X 10.11 (El Capitan)

OS X 10.10 (Yosemite)

OS X 10.9 (Mavericks)

Minimum processor Intel® Core™ 2 Duo

Minimum RAM 2 GB (4 GB for UHD displays)

Minimum hard disk
space

2.3 GB

Other requirements Adobe® Flash® Player 21 for SMART Notebook software

Safari application program 4.0.2 or later

Internet access to download SMART software

IMPORTANT

Some features require access to specific websites. Youmight need to whitelist those websites if

you restrict outbound Internet access. For further information, see SMART Notebook and

SMART Response VE add-ons behave unexpectedly behind a firewall or proxy.

Installation packages
There is one installation package (also known as a PKG file) for the Education Software Installer:

esi2016april.pkg. This installation package is located at the root of the DVD.

Alternatively, you can download the installation package from

smarttech.com/administratordownloads.

Activation connectivity
When you deploy SMART Notebook software, make sure the computers can access SMART’s web

activation services. Otherwise, the computers will not be able to activate product keys, during or

after installation.

http://knowledgebase.force.com/pkb_Home?q=15226
http://knowledgebase.force.com/pkb_Home?q=15226
http://www.smarttech.com/administratordownloads
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The activation web services are accessible at the following URLs:

l https://activationservice.smarttech.com/IntegrationCore?WSDL

l https://activationservice.smarttech.com/flexnet/services/ActivationService?WSDL

l https://webservices.smarttech.com/products/Activation_advanced.asmx?WSDL

When viewed in a web browser, each of the above URLs should display a WSDL document.

NOTE

If these sites are blocked by a proxy in your organization, add the URLs to the proxies.

SMART Install Manager and ActivationWizard will test these URLs and indicate success or failure.

When you use the SMART Install Manager tool, consider that you, as an administrator, may have

less restricted access to the Internet than standard users. It is important to install SMART Notebook

software on a standard user’s computer and use the ActivationWizard connectivity tester to

confirm connectivity.

Using SMART Install Manager
Start the connectivity tester by pressing the Check Activation Server button. The tester will appear

and show three green check marks to indicate success. SMART Install Manager will also prompt

you to use the connectivity tester at the time of publishing customizations.

Using ActivationWizard
In the ActivationWizard you can access the connectivity tester from the Advanced drop-down

menu in the lower left of the ActivationWizard. The tester will appear and show three green check

marks to indicate success.

See the Activation FAQ for more details and for information about other issues related

(smarttech.com/kb/170903).

https://activationservice.smarttech.com/IntegrationCore?WSDL
https://activationservice.smarttech.com/flexnet/services/ActivationService?WSDL
https://webservices.smarttech.com/products/Activation_advanced.asmx?WSDL
http://smarttech.com/kb/170903
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Chapter 2: Customizing the software

Using SMART Install Manager 5
SMART Install Manager controls 6

Removing SMART Install Manager 10

You can use SMART Install Manager to customize the software.

Using SMART Install Manager
Using SMART Install Manager, you can customize SMART software installation packages by

publishing PKG files. You can then deploy the SMART software to computers.

To install SMART Install Manager from the DVD

1. Insert the DVD in your computer’s DVD drive.

2. Browse to Administrators/Mac on the [DVD drive], and then

press SMART Install Manager.pkg.

The SMART Install Manager installation wizard appears.

3. Follow the on-screen instructions.

To download and install SMART Install Manager

1. Go to smarttech.com/administratordownloads.

2. Press Download under SMART Notebook collaborative learning software.

3. Press Looking for an older version of Notebook or know what software you need?.

4. Press SMART Install Manager, and then save the installer file to your computer.

5. Double-click the installer file.

The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.

http://www.smarttech.com/administratordownloads
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To customize education software 2016 using SMART Install Manager

1. Start SMART Install Manager.

2. Drag the installation package to the SMART Install Managerwindow.

3. Set the controls on each page (see SMART Install Manager controls below).

4. Select File > Publish.

A dialog box appears.

5. Browse to the location where you extracted the complete installer or the installation package.

6. Type a name for the PKG file, and then press Save.

7. Close SMART Install Manager.

SMART Install Manager controls

Control Procedure Notes

General Options: Product Selection

SMART Product Drivers Select to install SMART Product Drivers. [N/A]

SMART Ink Select to install SMART Ink. If you install SMART Ink, youmust install
SMART Product Drivers.When you select this
checkbox, SMART InstallManager selects
SMART Product Drivers automatically.

SMART Notebook
software

Select to install SMART Notebooksoftware.

Read the two notes regarding SMART’s new
software licensing, and then select the I
acknowledge the above note box located
under each note.

IMPORTANT

If you don’t select the two check license
acknowledgment checkboxes, the SMART
InstallManager will display a warning
messagewhen you try to publish the
configuration changes.

Product key Type your 25-character product key for
SMART Notebooksoftware.

You can type the product keywith or without
hyphens.

When you type a volume product key, the
software activates when you deploy it to your
networkcomputers.

SMART Response
software

Select to install SMART Response software. If you install SMART Response software, you
must also install SMART Notebooksoftware.
When you select this checkbox, SMART Install
Manager selects SMART Notebook
automatically.
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Control Procedure Notes

Product key If you’re installing SMART Response software
and students use SMART NotebookSE
(Student Edition) software or SMART Response
VE Internet-enabled devices to answer
questions, type your 25-character product key
for SMART Response software.

You can type the product keywith or without
hyphens.

When you type a volume product key, the
software activates when you deploy it to your
networkcomputers.

Delay activation Select to register the product keys on a system
without activating them.Registered keys can
be activatedwhen users start
SMART Notebooksoftware.

If you don’t select this setting, the software
automatically activates during installation
rather thanmanually after installation.

Delaying activation is useful for uniform
deployments that include users who don’t use
SMART Notebooksoftware.Only users who
start SMART Notebooksoftware activate
registered keys and consume a license.

Disable the License
Status dialog box

Select to prevent the software activation
reminder from appearing after
SMART Notebooksoftware starts.

When this checkbox is selected, the software
activation reminder appears onlywhen the
SMART Notebooksoftware trial period expires.

General Options: Installation Options

Start SMART System
Menu at logon

Select to start the SMART System

Menu when the user logs on.

[N/A]

SMART Technologies
Error Report

SMART Technologies Error Report installs by
default as part of the ESI 2016 installation.

This application installs by default as part of the
ESI 2016 installation, but can be turned off
through InstallManager.

General Options: Network/Firewall Settings

SMART lab features
operates as expected

Add the URLs to your teacher and student
network’s whitelist.

This setting confirms that the SMART lab
features operate correctly in SMART
Notebook.

General Options: SMART Product Update

Install SMART Product
Update in Fullmode

Select to install SMART Product Update (SPU) in
Fullmode.

[N/A]

Install SMART Product
Update in Dashboard
mode

Select to install SPU in Dashboardmode. [N/A]

Do not install SMART
Product Update

Select to not install SPU. [N/A]

Check for updates Type the number of days (1 to 60) between
SPUchecks.

This option is available only if you install SPU in
Fullmode.

By default, SPUchecks for product updates
every 30 days.

Notify users about
SMART product updates

Select to notify users of available SMART
product updates.

This option is available only if you install SPU in
Fullmode.

Reset per-user changes
to the previous two
settings

Select to remove existingCheck for updates
andNotify users about SMART product
updates values the next time the user runs
SPU.

This enables administrators to push new
values for these settings to computers and
ensures the new values are accepted.
Individual users can stillmodify these settings.
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Control Procedure Notes

General Options: Customer Experience

Enable the Customer
Experience Program on
all devices

Select to automatically enable the Customer
Experience Program for all users.

[N/A]

Disable the Customer
Experience Program on
all devices

Select to automatically disable the Customer
Experience Program for all users.

[N/A]

SMART Notebook: Gallery Content

SeeAppendix B: Installing
andmaintainingGallery
content on page 29

[N/A] [N/A]

SMART Notebook: Team Content

Team Content path Type the path to the Team Content folder,
which is a location on your school’s network
where users can store shared content.

[N/A]

SMART Notebook: My Content

MyContent path Type the path to theMy Content folder,which
is a location on the user’s computer where he
or she can store individual content.

[N/A]

SMART Notebook: Optional Settings

Install Adobe Flash Player Select to install Adobe Flash Player. Adobe Flash Player 21 or later is required for
SMARTNotebooksoftware.

SMART Response: Setup Tool

SMART Response LE Select to enable students to answer questions
with SMART Response LE clickers.

SMART Response PE Select to enable students to answer questions
with SMART Response PE clickers.
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Control Procedure Notes

SMART Response XE Select to enable students to answer questions
with SMART Response XE clickers.

SMART Response/Senteo Select to enable students to answer questions
with SMART Response or Senteo™ clickers.

SMART Response VE Select to enable students to answer questions
with SMART Response VE Internet-enabled
devices.

Multiple
SMART Response
devices in the same class

Select to enable students to answer questions
with Senteo,SMART Response,
SMART Response LE,SMART Response PE or
SMART Response XE clickers.

Select Include SMART Response VE to also
enable students to answer questions with
SMART Response VE Internet-enabled
devices.

[N/A]

SMART Response: Optional Settings

Start DesktopMenu at log
in for all users

Select to start SMART Response software
when the user logs on.

[N/A]

Install the education
standards database

Select to install the SMART Response
education standards database.

[N/A]

SMART Product Drivers: Optional Settings

Start SNMPAgent
services at logon

Select to enable SNMPAgent services. [N/A]

SMART Ink: Optional Settings

Start SMART Inkat logon Select to start SMART Inkwhen the user logs
on.

[N/A]
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Control Procedure Notes

Handwriting recognition: Language selection

Handwriting recognition:
Language selection

English is selected by default. You can also
select Czech,Danish,German,Hungarian,
Spanish, Finnish, French, Italian,Norwegian,
Dutch, Polish, Portuguese,Russian, Swedish,
andChinese (Simplified) in addition to English.

[N/A]

Removing SMART Install Manager
You can remove SMART Install Manager from your computer if you no longer need it. You can do

this using SMART Uninstaller or Terminal.

To remove SMART Install Manager using SMART Uninstaller

1. In Finder, browse to Applications/SMART Technologies, and then double-click

SMART Uninstaller.

The SMART Uninstallerwindow opens.

2. Select Install Manager, and then press Remove.

A dialog box appears, prompting you to confirm the removal.

3. Press OK.

4. Type your administrator password, and then press OK.

To remove SMART Install Manager using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Library/LaunchServices/com.smarttech.uninstallHelper" -i
com.smarttech.instllmgr10

3. Press RETURN.

4. Type your administrator password, and then press RETURN.
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Chapter 3: Deploying the software

After you customize the software with SMART Install Manager, you can deploy PKG files to the

computers on your network.

NOTE

Youmight need to manually activate the software after you deploy it.

There are many methods for deploying software installation packages. The following are two

commonmethods:

l Use Apple Remote Desktop software to manage your software installations.

l Use Terminal to install customized software on each computer.

NOTE

For more information on using Apple Remote Desktop software, refer to the documentation you

received with the software.

To deploy SMART software using Apple Remote Desktop software

1. Copy the PKG file that you created with SMART Install Manager to a server that is accessible

to all the computers you want to install the software on.

2. Using Apple Remote Desktop software on the server, select the computers that you want to

update.

3. Select Install Packages.

A dialog box appears.

4. Drag the PKG file to the Packages box in the dialog box.

5. Click Install.

The software installs on the selected computers.
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To deploy SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

sudo installer -target / -pkg "[Path]/[File name].pkg"

Where

o [Path] is the path to the PKG file.

o [File name] is the name of the PKG file.

NOTE

This command installs only SMART Notebook software, SMART Product Drivers and

SMART Response software if you haven’t customized the PKG file using SMART Install

Manager.

3. Press RETURN.

4. Type your administrator password, and then press RETURN.
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Chapter 4: Activating and renewing the
software

Activating the software during installation 13
Activating the software after installation 13
Renewing keys 15

Renewing keys in unattended mode 16
Renewing keys in user interface mode 17
Enabling and disabling automatic renewal of keys 18

Using SMART Product Update (SPU) to retrieve activation status 19
Returning a product key activation with a command-line script 19

Activating the software during installation
If you want to activate SMART Notebook software during deployment, you can use either of the

following practices, depending on your deployment method:

l System imaging: If you use system imaging, do not activate the software before you freeze

the image. You can use the Delayed Activation feature to register your product key on the

system before freezing it. After the image is deployed, SMART Notebook software, will

prompt you to activate the registered product key. (see Delay Activation procedure in the

table under SMART Install Manager controls on page 6).

l Network deployment: If you use a network deployment tool such as Apple Remote Desktop,

you can specify your product key normally in Install Manager or by using command-line

parameters. Activation will occur during installation on each individual computer.

Activating the software after installation
There are two situations in which the software doesn’t activate completely:

l Imaging a computer: Activation is linked to the hardware identifier of the computer on which

the software is installed and activated. If you clone a hard drive image with installed and
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activated software, youmust activate the software on each cloned computer.

l Reverting a computer to an earlier state: If you use system recovery or protection software

that periodically restores the computer to an earlier state, youmight need to activate the

software before locking the computer so that the activation record is not cleared each time

the computer is restored.

Run the activation wizard while the computer is connected to the network, or complete the

following procedure to activate the software on each computer.

NOTE

SMART Product Drivers don’t require activation.

To activate SMART software after installation

1. In Finder, browse to /Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard
--puid education_bundle --uipack education_bundle --m=4 --v=3 --pks
"[Product keys]" --a

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code.

o Where [Product keys] are one or more software product keys separated by commas.

3. Press RETURN.

4. Type your administrator password, and then press RETURN.
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To activate only SMART Response software after installation

1. In Finder, browse to /Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard
--puid response_16 --uipack response_3 --m=4 --v=3
--pks "[Product keys]" --a

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code.

o Where [Product keys] are one or more software product keys separated by commas.

3. Press RETURN.

4. Type your administrator password, and then press RETURN.

NOTE

This command is applicable only if you’re running SMART Response software in VE mode

(where students answer questions with Internet-enabled devices). Instructions for activating

all other modes are included in the SMART Response documentation.

Renewing keys
If your school has purchased maintenance or subscription licenses, SMART software attempts to

renew the keys automatically on a scheduled basis before and after the keys’ expiry dates.

However, you can choose to explicitly renew the keys at a specified time. You can also choose to

disable automatic renewal in situations where you don’t want the keys on a computer to be

renewed (because, for example, you’re planning to retire the computer).
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TIP

The activation wizard user interface distinguishes betweenmaintenance and subscription

licenses:

l Maintenance licenses are labeled with “Valid for versions released before [Date]”.

l Subscription licenses are labeled with the expiration date of the key.

Renewing keys in unattended mode

To renew all keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=15 --v=3
--renewal-mode all

To renew all keys associated with a single product

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=15 --v=3
--renewal-mode product --puid=[Product]

Where [Product] is response_16 or education_bundle.

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=15 --v=3
--renewal-mode product --puid=[Product] "[Product keys]"

Where
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o [Product] is response_16 or education_bundle.

o Where [Product keys] are one or more software product keys separated by commas.

Renewing keys in user interface mode

To renew all keys associated with a single product

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=16 --v=3
--renewal-mode product --puid=[Product] --uipack=[UI pack]

Where

o [Product] is response_16 or education_bundle.

o [UI pack] is the corresponding UI pack for the selected product (response_3 or

education_bundle).

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=16 --v=3
--renewal-mode product --puid=[Product] --uipack=[UI pack]
"[Product keys]"

Where

o [Product] is response_16 or education_bundle.

o [UI pack] is the corresponding UI pack for the selected product (response_3 or

education_bundle).

o Where [Product keys] are one or more software product keys separated by commas.
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Enabling and disabling automatic renewal of keys

To enable automatic renewal of specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=17
--puid=[Product] --v=3 --auto-renew "[Product keys]"

Where

o [Product] is response_16 or education_bundle.

o Where [Product key] is the software product key.

To disable automatic renewal of specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=17
--puid=[Product] --v=3 --no-auto-renew "[Product keys]"

Where

o [Product] is response_16 or education_bundle.

o Where [Product keys] are one or more software product keys separated by commas.

To disable automatic renewal on a computer

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=18 --v=3
--no-auto-renew

To enable automatic renewal on a computer

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
activationwizard.app/Contents/MacOS/activationwizard --m=18 --v=3
--auto-renew
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Using SMART Product Update (SPU) to retrieve
activation status
You can use SMART Product Update (SPU) from the command line to retrieve information on SPU

settings and activation status. You could use this in scripts with industry standard execution tools to

retrieve information on your network’s computers.

To use SPU to retrieve activation status

Run the following command:

"/Application/SMART Technologies/SMART Tools/SMART Product
Update.app/Contents/MacOS/SMART Product Update" --query [Options] >
OutputFile.txt 2> /dev/null

NOTES

o OutputFile.txt is the file in which you record the results. The path to this file can be

absolute or relative. When specifying a path to a folder, make sure you have write

permissions to that folder.

o The 2> /dev/null command suppresses any messages that appear on the Standard

Error output stream.

o [Options] is used for the following optional parameters:

o --format [Format]

Valid values for [Format] are CSV, JSON or XML. The JSON and XML format

provides full details, nand CSV formats provide basic information.

o --key [Key]

This parameter is used to narrow down the returned results. The appropriate

format for this parameter is JSON or XML.

o The 64-bit version of this command uses the same options and parameters as the 32-

bit version.

Returning a product key activation with a
command-line script
As of version 16.0, SMART Notebook supports the return of a product key activation with a

command-line script. An activationwizard.exe command can be deployed across the network to

return the activation from several computers, making the product key available for use on other
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computers.

You can specify multiple keys in one command by using the command format below.

To return product keys

Run the following command:

/Library/Application\Support/SMART\Technologies/activationwizard.app/Contents
/MacOS/activationwizard --puid notebook_16 --m=4 --v=3 --return --pks=
[Product key],[Product key]
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Chapter 5: Updating the software

SMART periodically releases updates to its software. These updates add new features and resolve

issues.
Go to smarttech.com/software to download the latest updates.

To update software

1. Download the DMG file from the website.

2. In Finder, browse to and double-click Applications/SMART Technologies/

Install Manager.

The SMART Install Managerwindow appears.

3. Open the DMG file you downloaded (see Chapter 2: Customizing the software on page 5).

4. Customize the file by setting the controls on each page.

OR

Apply customizations that you previously created for an earlier version and saved in an XML

file (see Chapter 2: Customizing the software on page 5) by selecting File > Import, browsing

to the XML file, and then clicking Open.

5. Publish your customizations as a PKG file (see Chapter 2: Customizing the software on

page 5), and then deploy the PKG file to computers on your network (see Chapter 3:

Deploying the software on page 11).

http://www.smarttech.com/software
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Chapter 6: Uninstalling the software

Using SMART Uninstaller 23
Using Apple Remote Desktop 24
Using Terminal 25

After installing education software 2016, you can use SMART Uninstaller, Apple Remote Desktop

or Terminal to uninstall the software.

Using SMART Uninstaller

To uninstall education software 2016 using SMART Uninstaller

1. In Finder, browse to Applications/SMART Technologies, and then double-click

SMART Uninstaller.

2. Select the software you want to uninstall.

NOTES

o Some SMART software is dependent on other SMART software. If you select this

software, SMART Uninstaller automatically selects the software on which it depends.

o SMART Uninstaller automatically uninstalls any supporting software that is no longer

being used. If you choose to uninstall all SMART software, SMART Uninstaller

automatically uninstalls all supporting software, including itself.

TIPS

o To select more than one software application, hold down SHIFT or COMMANDwhile

selecting the software applications.

o To select all software applications, press Select All.

3. Press Remove, and then press OK.
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4. If prompted, enter a user name and password with administrator privileges, and then press OK.

SMART Uninstaller uninstalls the selected software.

5. Close SMART Uninstaller when done.

Using Apple Remote Desktop

NOTE

For general information on using Apple Remote Desktop, refer to the documentation you

received with the software.

To uninstall education software 2016 using Apple Remote Desktop

1. Using Apple Remote Desktop on the server, select the computers that you want to update.

2. Press UNIX.

A dialog box appears.

3. If you want to uninstall all SMART software, type the following command:

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --all

NOTE

This command uninstalls all SMART software from 2012 or later.

OR

If you want to uninstall select SMART software, type one of the following commands:

o SMART Notebook software

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i com.smarttech.notebook10

NOTE

If any SMART Notebook dependent software, such as SMART Response software, is

installed, the above command uninstalls it automatically.
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o SMART Product Drivers

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall"
-i com.smarttech.boardDrivers.pkg

o SMART Response software

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i com.smarttech.senteo1

4. Under Run command as, press User, and then specify the root user.

5. Press Send to uninstall the software from your network computers.

Using Terminal

To uninstall all SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --all

3. Press RETURN.

4. Type your administrator password, and then press RETURN.

NOTE

This command uninstalls all SMART software from 2012 or later.

To uninstall select SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --list
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3. Press RETURN.

A list of available package IDs appears.

4. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i [Package ID]

Where [Package ID] is the ID of the package you want to uninstall.

NOTE

You can type multiple instances of -i [Package ID] to uninstall multiple packages in the

same command. For example:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i com.smarttech.notebook10
-i com.smarttech.boardDrivers.pkg

5. Press RETURN.

6. Type your administrator password, and then press RETURN.
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Appendix A: Languages

The following are the languages supported by all products in the Education Software Installer:

l English (U.S.)

l English (UK)

l Czech

l Chinese (Simplified)

l Danish

l Dutch

l Finnish

l French

l German

l Italian

l Hungarian

l Norwegian

l Polish

l Portuguese (Brazil)

l Russian

l Spanish

l Swedish
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Appendix B: Installing and maintaining Gallery
content

Gallery content includes the following:

l Gallery Essentials, which is a collection of educational photos and other images, audio files,

and Adobe Flash Player compatible files.

l Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson

activities.

You can access Gallery content from the Gallery tab in SMART Notebook software.

Configuring Gallery content using SMART Install
Manager
Complete the procedure in this section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1. Open the software installation package in SMART Install Manager.

2. Click Product Selection.

The Product Selection page appears.

3. Select SMART Notebook (and any other products you want to install).

4. Click Gallery Content.

The Gallery Content page appears.

5. Select the Gallery content to be installed on each computer

Gallery Essentials

Lesson Activity Toolkit

6. Publish your changes as a PKG file, and then deploy the PKG file.
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Working Gallery content locations
After installing the software, you can do the following:

l Starting the software in Administration mode.

l Change the location of the My Content folder.

l Create or connect to a Team Content folder.

l Connect to an RSS feed.

Starting the software Administration mode
Before you canmaintain content folders, youmust start the software in Administration mode.

To start SMART Notebook software in Administration mode

1. In Finder, browse to /Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

sudo /Applications/SMART\ Notebook/Notebook.app/Contents/ MacOS/Notebook -
admin

3. Press RETURN.

4. Type your administrator password, and then press RETURN.

SMART Notebook software starts in Administration mode.

Changing the location of the My Content folder
The My Content folder is a location where teachers and students can store content for their

individual use.

You can specify the location of the My Content folder during installation. If you don’t specify a

location, the default location is /Library/Application Support/SMART Technologies Inc/Gallery/My

Content.

To change the location of theMy Content folder after installation

1. Start the software in Administration mode.

2. Click the Gallery tab.
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3. Click the Click here for more Gallery options icon, and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Click Browse.

The Open dialog box appears.

5. Browse to and select the new My Content folder, and then click OK.

6. Click Close.

7. Close the software.

Creating or connecting to Team Content folders
All users can create new content and save it in theirMy Content folders. To allow users to share

content, you must create or connect to a Team Content folder.

TIP

If you create a Team Content folder on a computer’s hard disk, the folder is available only to

users of that computer. However, if you create a Team Content folder on a server, the folder is

available to all users on the school’s network with read and write access to the folder.

To create a new Team Content folder

1. Start the software in Administration mode.

2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon, and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Click Create New.

The Open dialog box appears.

5. Browse to and select the folder you want to designate as a Team Content folder, and then

click Open.

6. Click Close.

7. Close the software.
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To connect to an existing Team Content folder

1. Start the software in Administration mode.

2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon , and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Click the + button.

The Open dialog box appears.

5. Browse to and select the Team Content folder, and then click Open.

6. Click Close.

7. Close the software.

To disconnect a Team Content folder

1. Start the software in Administration mode.
2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon, and then select Administration:Content

Locations.

The Administration: Content Locations dialog box appears.

4. Select the folder in the Team Content list, and then click the – button.

IMPORTANT

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for

those collections appear in the Team Content list. Do not remove these folders from the list,

or users will not be able to access these collections.

5. Click Close.

6. Close the software.

Connecting to an RSS feed
You can connect to a public or private RSS feed to send information to your school’s SMART

Notebook software and SMART Notebook SE users through the Gallery tab.
RSS is a format for delivering regularly changing web content. Many news-related websites, blogs

and other publishers broadcast their content as RSS feeds.
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To connect to an RSS feed

1. Start the software in Administration mode.

2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon , and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Type the URL of the RSS feed in the Online Resources box.

5. Click Close.

6. Close the software.
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